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ABSTRACT OF THE THESIS 

 

Establishing CellROX Deep Red as a Radical Dosimeter for Fast Photochemical Oxidation of 

Proteins (FPOP) 

 

 

by 

 

Imani Lillian Ross 

 

Master of Science in Chemistry 

 

University of California San Diego, 2024 

 

Professor Lisa M. Jones, Chair 

 
 

Hydroxyl radical protein footprinting (HRPF) coupled to mass spectrometry (MS) is a 

vital technique in determining the higher order structure of proteins. This method uses hydroxyl 

radicals to oxidatively modify solvent-accessible amino acids and has recently been extended to 

in-cell analysis.4 Specifically, HRPF via in-cell fast photochemical oxidation of proteins (IC-
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FPOP) is a relatively new approach to labelling proteins, with the ability to modify 19 of the 20 

amino acids. FPOP uses an excimer laser to split hydrogen peroxide (H2O2) into hydroxyl 

radicals, which are then able to react with, and thus label solvent-accessible surface residues of a 

protein on the microsecond time scale. In Lisa Jones’s lab, in-cell protein footprinting has been 

coupled with mass spectrometry to discern protein structure in-cell. Specifically, IC-FPOP has 

been implemented in a Platform Incubator with a movable XY stage (PIXY)3 and used to 

successfully modify proteins in several commonly used cell lines.4 However, there remains a gap 

in the IC-FPOP methodology pertaining to the effective radical dose delivered to the cellular 

environments. While IC-FPOP is an effective avenue of HRPF, a challenge that remains is 

maintaining reproducibility as it pertains to the concentration of radical that is delivered to the 

system, or the effective radical dose, of hydroxyl radicals reacting with the protein. Effective 

radical dose is affected by the amount of radical delivered as well as the presence of other 

substances, such as radical scavengers. While dosimetry experiments for HRPF via FPOP have 

been done before in other labs, there is currently no protocol for dosimetry for IC-FPOP. 

CellROX Deep Red is a fluorescent probe that fluoresces only in the presence of reactive 

oxidative species (ROS). I propose probing the efficacy of the fluorophore CellROX Deep Red 

as a radical dosimeter for IC-FPOP. I will first troubleshoot and optimize the fluorescence 

imaging of HEK293 cells with CellROX Deep Red directly following their oxidation. I will then 

conduct imaging of the cells having been exposed to increasing values of hydrogen peroxide 

concentrations in order to demonstrate a linear response of the dosimeter CellROX Deep Red.
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Chapter 1 Incorporating Dosimetry into an IC-FPOP Workflow 

 

Hydroxyl radical protein footprinting (HRPF) by fast photochemical oxidation of proteins 

(FPOP) is a labeling technique that provides structural information by modifying solvent 

accessible amino acids. It has been pivotal in studying the higher order structure of proteins. IC-

FPOP is a growing technique being used in mass spectrometry-based proteomics that enables the 

examination of protein conformations within an intricate cellular environment. 

A dosimeter enables the accurate measurement of the radical dose delivered to the cell, 

increasing reproducible and reliable results. The Joshua Sharp group at the University of 

Mississippi has developed adenine as a radical dosimeter for in-vitro FPOP. Adenine absorbance 

decreases as it is oxidized.5 The Sharp group has successfully used dosimetry to perform 

compensated FPOP where radical scavenging is accounted for and compensated for using 

dosimetry.8 However, adenine would not be an appropriate dosimeter for IC-FPOP owing to both 

the endogenous levels of this molecule in cells and the difficulty in monitoring a loss of signal in 

a complex sample.  

HRPF techniques are limited by their ability to deliver a defined concentration of 

hydroxyl radicals to the protein. This ability is impacted by both the amount of radical generated 

and the presence of radical scavengers in solution. In order to compare HRPF data from sample 

to sample, a hydroxyl radical dosimeter is needed that can measure the effective concentration of 

radical that is delivered to the protein, after accounting for both differences in hydroxyl radical 

generation and nonanalyte radical consumption.7 

CellROX Deep Red is a radical dosimeter that has an emission of 644 to 665nm (Cy5 

was used for fluorescence imaging, as its wavelength ranges from 649 to 669 nm). It fluoresces 

only in the presence of ROS when it becomes oxidized. The Jones lab has previously used this 
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fluorophore to demonstrate that cells were intact after the completion of IC-FPOP.2 CellROX 

Deep Red localized in the cytoplasm, leaving the nucleus intact. This work demonstrated the 

potential of using CellROX Deep Red as a dosimeter for IC-FPOP. 

Human embryonic kidney 293 (HEK293) cells were used for the purposes of IC-FPOP 

experimentation. In addition to its ease of growth in serum-free suspension culture and its 

amenability to transfection, this cell line’s most important attribute is its human origin, which 

makes it suitable to produce biologics intended for human use.1 Human embryonic kidney 

(HEK) cell lines provide systems that exhibit wide versatility.6  

 

IC-FPOP Sample Preparation 

 To make a collagen solution, 1.06 mL of 3.6 mg/mL collagen was added to 98.94 mL (19 

g/mL) of cell culture water to make a 100 mL. To a six-well plate, 2 mL of the collagen 

solution was added to each well, coating them in 6-10 g/cm2. The protein was allowed to bind 

to the plate overnight at 4C. The next day, excess fluid was removed from the coated surface, 

and the plate was returned to 4C and allowed to dry overnight. The coated surfaces were 

sterilized the next day with three UV cycles of exposure to UV light in a sterile tissue culture 

hood. 

 In one T175 flask, HEK293 cells were grown to 80% confluency. One T175 was used to 

prepare three collagen-coated plates. Collagen plates were rinsed with tissue culture water. The 

HEK293 cells were rinsed with 7mL of PBS and detached from the bottom of the flask with 2mL 

of trypsin. The trypsin was neutralized in 10 mL of DMEM media supplemented with FBS and 

streptomycin-penicillin (P/S). The media was removed, the cells were resuspended in 23 mL of 

the media, and 1 mL of the cell suspension was added to each well. An additional 3 mL of media 
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was added to each well. The well plates were placed in a 37C incubator until cells reached 80% 

confluency. 

 The day before IC-FPOP, 500 mL of a 125 mM quench solution containing 125 mM of 

PBN, 125 mM of DMTU, and 1% DMSO (added on the day of IC-FPOP) was made and 

solubilized in 500 mL Millipore water. The quench solution was mixed at 4C. On the day of IC-

FPOP experimentation, 8 L of CellROX Deep Red (final concentration of 5 M) was added to 

each well. The six-well plates were incubated for 30 minutes at 37C. Afterwards, the media was 

removed, and the cells were rinsed thrice with PBS. 

PIXY 2.0 

IC-FPOP utilizes a sterile incubation system containing a mobile stage for movement in 

the XY direction as well as peristatic pumps featuring perfusion lines for chemical transport, and 

mirrors to focus and direct the laser beam. PIXY is partnered with software that provides 

automated communication between the pumping system and the laser to facilitate the execution 

of the entire system. The second-generation PIXY system has an ECHO revolve fluorescence 

microscope added (Figure 1). To accommodate movement of the stage top incubator for 

fluorescence imaging, an extended rail system was also added. After IC-FPOP of an individual 

well the stage top incubator is moved toward the microscope for fluorescence imaging. The laser 

light is irradiated downward onto an individual well of the plate. The rail system moves the 

incubator so that the next well is in the pathway of the laser irradiation. 

While the PIXY automation was not functional during experimentation, samples were 

still handled in the incubator, using one of the pumps for H2O2 and quench application. For 

irradiation of each well, the flow automation was instituted, and once one well’s sample was 
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irradiated, the plate was manually transferred to the fluorescence microscope, where 

fluorescence imaging was conducted. 

 

Figure 1: PIXY 2.0. The second-generation PIXY system has an ECHO revolve fluorescence 

microscope added. To accommodate movement of the stage top incubator for fluorescence 

imaging, there is also an extended rail system.3 After IC-FPOP of an individual well the stage top 

incubator is moved toward the microscope for fluorescence imaging. 

IC-FPOP to Test [H2O2] Gradient 

 Five concentrations of H2O2– 0mM, 20mM, 40mM, 80mM, and 100mM—were prepared 

in PBS. The 248 nm excimer laser was powered on and allowed to warm up. The PIXY 

Benchmark Script (Figure 2) was opened in LabVIEW, and the script was tested to ensure 

adequate liquid flow. Then, the quench solution and 0mM [H2O2] (i.e. PBS) were run until their 

respective lines were filled. 

 Once the laser was warmed up, the laser energy was tested using the Ophir Sensor at each 

of the mirrors and at the incubator’s base where the sample would be. If the average laser energy 
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was not at least 120 mJ at the incubator’s base, the laser gas was partially emptied and refilled. 

The laser energy was tested at each of the three locations after each gas refill. PIXY was then 

aligned by adjusting the rail system until the laser irradiated a single well of the six-well plate in 

its entirety. After laser alignment, the laser was set to 50 Hz, 26.00 kV, and to 1 pulse. 

 After being incubated with CellROX Deep Red for thirty minutes, removal of media, and 

three PBS rinses, the HEK293 cells were placed in the stage top incubator. Tubes primed with 

H2O2 and the quench solution were fed into the sides of the stage top incubator. The fully 

automated script was initiated, and the laser fired immediately following the addition of the 

H2O2. IC-FPOP was conducted at each [H2O2] using the laser and without the laser (non-laser). 

  

Figure 2: LabVIEW PIXY Benchmark script for a six-well plate. 

Fluorescence Imaging 

 Fluorescence imaging was conducted on the Echo Revolve fluorescence microscope 

directly following the addition of the quench solution. The microscope’s objective was set to 

1.25X|0.3, and sample protection (SP) was selected. The sample plate was placed on the 

microscope’s dock and adjusted until focused on the well prepared for imaging. Transmitted 
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Light (TRANS) mode was selected for viewing of the sample under brightfield conditions to 

ensure the microscope lens was properly focused and that cells were still adhered to the well 

plate. ‘Levels’ was set to auto, so the microscope’s software automatically adjusted the 

brightness and contrast based on the image data being received. If images were out of focus, the 

necessary adjustments were made. Cy5 mode was then selected, and the sample was viewed. The 

imaging focus was again checked and adjusted. Once the image was as focused as possible, it 

was captured as .tiff (for image analysis) and jpeg files (for image viewing) and saved. Figure 3 

demonstrates IC-FPOP workflow from coating collagen plates to fluorescence imaging. 

 

 Figure 3: IC-FPOP Workflow. 

Results and Discussion 

Baseline imaging of samples at 100 mM [H2O2] only were done to ensure sample 

fluorescence was successful. After this was confirmed, IC-FPOP and fluorescence imaging was 

done in triplicates for all five [H2O2] under laser and non-laser conditions. Initial fluorescence 

imaging showed that in some of the wells, cells had become detached from the collagen-coated 

well plate making clear imaging difficult. Image analysis was conducted on the Echo Revolve 

first, with the blurred images and then, a second time, removing the blurred images from the data 

pool. To determine the fluorescence intensity of sample images, the area of the image was 

selected on the Echo Revolve, producing the intensity output. The triplicate fluorescence 

intensities were averaged for each [H2O2] and graphed as mean fluorescence intensity (au) versus 

[H2O2] (mM). Predictably, the inclusion of the visibly blurred images resulted in no trend 

between fluorescence intensity and [H2O2]. However, when the blurred images were not 
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included, a trend became clear. Results showed that while there was an upward trend in 

fluorescence as the H2O2 gradient increased, indicating successful oxidation and a linear 

response of CellROX Deep Red as a dosimeter in IC-FPOP, at 80 mM [H2O2] and higher, 

fluorescence was shown to have begun decreasing (Figure 4). 

These results suggest that photobleaching, probe degradation, fluorescence quenching, 

sample degradation, probe diffusion, or another factor may have contributed to the declining 

mean fluorescence intensity after 40 mM [H2O2]. 

 
Figure 4: Dose response curve of CellROX Deep Red in laser samples at different concentrations 

of hydrogen peroxide (0, 20, 40, 80, and 100 mM). Fluorescence at 649-669 nm of 5 mM 

CellROX Deep Red with (a) different concentrations of hydrogen peroxide (0, 20, 40, 80, and 

100 mM); different concentrations of hydrogen peroxide (0, 20, and 40mM) before fluorescence 

degradation; (c) different concentrations of hydrogen peroxide (40, 80, and 100 mM) after 

fluorescence degradation. Each data point is an average of two to three IC-FPOP oxidation 

replicates.  
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Chapter 2 Troubleshooting and Optimization of Fluorescence Imaging 

 

Fluorescence imaging under the previously outlined conditions proved insufficient. To 

address this, limitations of the fluorescence probe were taken into consideration. First, a method 

was sought out to improve the determination of mean fluorescence intensity. To improve 

fluorescence imaging analysis, different thresholds were assessed in ImageJ, a National Institute 

of Health (NIH) and Laboratory for Optical and Computational Instrumentation (LOCI) 

developed Java-based image processing program. Likewise, all experimentation was conducted 

in the dark to limit sample exposure to background light. The microscope’s objective setting was 

changed to 10X|0.3 for clearer imaging. These changes were applied to a second group of trials. 

Another concern was gaining better imaging coverage of wells, as the microscope being 

used only covered part of a single well. A more reliable, precise, and efficient method for 

determining the mean fluorescence intensity of an entire well was sought. This change as well as 

the changes from the previous paragraph were applied to a third group of trials. 

Analysis in ImageJ: Testing Different Thresholds 

An adjustment that was made was in the manner in which mean fluorescence intensity 

was calculated. Previously, the Jones lab manually determined the mean fluorescence intensity 

by focusing on three sections of cells in a well and averaging their intensities on the Echo.2 

However, an ImageJ protocol was developed to better analyze fluorescence images using 

thresholds. 

 Thresholds are computational methods used to transform a greyscale image into a binary 

image for analysis. Thresholds are necessary because fluorescence images typically have regions 

of varying intensity levels, and thresholding helps isolate regions the regions where intensity 

exceeds a certain level, focusing on fluorescently labeled areas relevant to analysis. Thresholding 
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also helps to reduce background fluorescence, reducing noise. All sixteen available thresholds 

were attempted on the first of the .tiff images to gauge which auto threshold demonstrated visible 

areas of fluorescence comparable to the jpeg image. The most comparable threshold for the first 

0mM [H2O2] trial was Triangle. However, this proved to be an ineffective method, as the optimal 

threshold changed from image to image due to variability in lighting and focus of each of the 

captured images. Therefore, a manual thresholding method was adopted. 

Image J Protocol Using Manual Thresholding 

 The most recent version of ImageJ (ImageJ 1.53t) was downloaded and opened. The 

applicable measurements were selected ("Analyze” => “Set Measurements) as “Area,” 

“Standard deviation,” “Min & max gray value,” “Mean gray value,” and “Display label” (Figure 

6). “Redirect to:” was set at “None,” and the number of decimal places was set to three. "OK” 

was pressed to set the selected measurements. 

 

Figure 5: ImageJ Set Measurements. 

To begin fluorescence imaging analysis, the first .tiff sample file was opened in ImageJ 

(“File” => “Open” => Select .tiff file). An auto threshold method was applied to the .tiff image 
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(“Image” => “Adjust” => “Threshold,”) bringing up a histogram and threshold settings (Figure 

7). The auto-threshold method was disregarded, as thresholding was done manually. The display 

mode was set to “Red.” “Dark background” and “Don’t reset range” were selected. Using 

the slider directly below the histogram, the threshold range was adjusted to exclude everything 

but the right-most tail end of the peak; everything within the red rectangle was included in the 

threshold range. The manually adjusted image was compared to the jpeg image to ensure the 

image matched the fluorescence visible in the jpeg, after which the threshold was set by pressing 

“Apply.” Mean fluorescence intensity was measured (“Analyze” => “Measure.”) This was done 

for all .tiff images.  

 

  Figure 6: Manual Thresholding in ImageJ. 

IC-FPOP Using A 24-Well Plate 

 Twenty-four-well collagen plates were used to ensure better fluorescence imaging 

coverage. At this smaller size, the imaging scope was able to cover the entirety of a single well, 

rather than just a part of it. The LabVIEW script was likewise modified to accommodate a 

twenty-four well-plate (Figure 5), with adjusted volumes to match the target concentrations 

outlined in the above chapter. 
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Figure 7: LabVIEW 24-well automated script. 

Data and Results 

 Manual thresholding of the trials was completed for the second group of trials, which was 

done in a six-well plate. The results showed a linear response, where, as the concentration of 

H2O2 increased, so did the mean fluorescence intensity through 80 mM [H2O2] (Figure 8). 

However, there was a decrease in mean fluorescence intensity from 80 mM to 100 mM [H2O2], 

indicating fluorescence degradation.  

Results for the trials in the 24-well plate using manual thresholding resulted in a linear 

response (Figure 9), demonstrating a positive correlation between mean fluorescence intensity 

and [H2O2]. However, it should be noted that only two trials were completed for each 

concentration of hydrogen peroxide.  
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Figure 8: Dose response curve of CellROX Deep Red in laser samples at different concentrations 

of hydrogen peroxide (0, 20, 40, 80, and 100 mM) after manual thresholding in ImageJ. 

Fluorescence at 649-669 nm of 5 mM CellROX Deep Red with (a) different concentrations of 

hydrogen peroxide (0, 20, 40, 80, and 100 mM); different concentrations of hydrogen peroxide 

(0, 20, 40, and 80 mM) before fluorescence degradation. Each data point is an average of three 

IC-FPOP oxidation replicates. 

 

 

 

 

Figure 9: Dose response curve of CellROX Deep Red in 24-well plate laser samples at different 

concentrations of hydrogen peroxide (0, 20, 40, 80, and 100 mM) after manual thresholding in 

ImageJ. Fluorescence at 649-669 nm of 5 mM CellROX Deep Red with different concentrations 

of hydrogen peroxide (0, 20, 40, 80, and 100 mM). Each data point is an average of two IC-

FPOP oxidation replicates. 
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Potential Pitfalls/Alternative Directions 

The time it takes to manually complete the IC-FPOP workflow may have had an impact 

on the results of laser versus non-laser samples. The amount of time CellROX Deep Red was in 

contact with the sample may have affected the intensity reading. As IC-FPOP on the laser 

samples was done last, this may be why by the time they underwent IC-FPOP (more than an hour 

after incubation), the signal had begun to fade, resulting in a lower fluorescence intensity in 

some samples. On the other hand, fluorescence in the non-laser samples may have been observed 

as a result of background oxidation. Fixing the PIXY automation should become next priority to 

reduce time as a factor and make the IC-FPOP process more precise and efficient. 

It was further noted that manual thresholding often introduces bias to fluorescence 

imaging analysis. To account for this, manual thresholding was compared to the visible 

fluorescence in the jpeg image. Also, mean fluorescence intensity measurements weren’t viewed 

until after all the samples had been thresholded. Despite this, a more unbiased and efficient 

method should be determined for future ImageJ fluorescence imaging. 
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CONCLUSION 
 

Although a linear response of the radical dosimeter CellROX Deep Red was not 

definitively established, results proved positive, showing an upward trend in oxidation to a 

certain extent. While increasing H2O2 concentration did not result in increased fluorescence 

intensity in all samples as expected, there was a correlation in the six-well plate trials, as 

evidence by increasing fluorescence below 80 mM after excluding outliers (due to grainy or 

blurred imaging) for the first set of trials and 100 mM in the second set. However, above 60 mM 

[H2O2] and 80 mM respectively, fluorescence intensity began to decline. The reason behind this 

decrease may have been due to photobleaching, probe degradation, fluorescence quenching, 

sample degradation, probe diffusion, or a number of other reasons. More experimentation is 

needed to draw further conclusions. 

Potential Pitfalls/Alternative Directions 

Should CellROX Deep Red not present a linear relationship with fluorescence intensity, 

other fluorescence probes such as hydroxyphenyl fluorescein (HPF), 2-(6-(4’-amino) phenoxy-

3H-xanthen-2-on-9-yl) benzoic acid (APF), or 5,5-dimethyl-1-pyrroline N-oxide (DMPO), 

which fluoresce only in the presence of hydroxyl radicals, may be used. These probes are already 

accessible in the lab and are promising alternatives should CellROX Deep Red prove non-linear. 

An alternative method to address the time it takes to conduct fluorescence imaging and 

the effect this has on the fluorescence probe would be to introduce a fixative to samples (i.e. 

formaldehyde). Adding a fixative such as formaldehyde would increase the length of time before 

degradation of the fluorophore to provide more time to take focused fluorescence images. 
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Future Directions 

 Several trials at 0 mM only should be done to determine the best fluorescence imaging 

settings for minimal fluorescence. This was conducted for 100 mM to confirm a fluorescent 

response. However, after optimal fluorescence imaging settings are determined from the 0 mM 

trials, another set of 100 mM trials should be conducted to ensure fluorescence is still observed 

under the new settings. 

Once a linear response is established, the effect of laser energy and DMSO on effective 

radical dose should be tested in order to optimize the conditions for HRPF experiments (Table 

1). It is expected that there will be a positive correlation between mean fluorescence intensity 

and laser energy, whereas for mean fluorescence intensity and DMSO, there will be a negative 

correlation, as DMSO is a radical scavenger. 

Table 1: Experimental outline with predicted outcomes. A) [H2O2] gradient: B) Laser Energy 

gradient: C) DMSO gradient: 

Condition [H2O2] (mM) Laser Energy (mJ) DMSO 

(mM) 

Predicted Outcome 

A 0-150 110 0 Directly Proportional 

B 100 Gradient (40-160) 0 Directly Proportional 

C 100 110 0-0.5% Indirectly Proportional 

Control 100 0 0 N/A 
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